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1. โครงสรšางของ Software EasyMatch QC Electronic Record (ER) 

 ซอฟตŤแวรŤสำหรับปฏิบัติตามขšอกำหนด 21 CFR11 

 

2. ขั้นตอนการเปŗดเคร่ืองวัดสีและ Software 

1.เปŗดเครื่องวัดส ีColorFlex EZ   

2.เปŗดเครื่องคอมพิวเตอรŤ 

3.เปŗด Software EasyMatch QC-ER     

4.Standardize ที่ไอคอน   กŠอนเริ่มใชšงานทุกครั้งที่เปŗดเครื่องใหมŠ  

5.พรšอมใชšงาน 

 



 
 

 
5 

 

3. ขั้นตอนการปŗด Software และปŗดเคร่ืองวัดสี  

 1.Save file     การวัดคŠาสีตัวอยŠาง 

 2.Close หรือ Exit   ออกจาก Software EasyMatch QC-ER 

 3.Shutdown เครื่องคอมพิวเตอรŤ 

 4.ปŗดเครื่องวัดส ีColorFlex EZ 

 

4. วิธีสรšาง Group Admins และผูšใชšงาน Admin 

 1.วิธีการสรšาง Group Admins 

 2.วิธีการสรšาง User Admin 

 3.วิธีการนำ User ใสŠใน Group Admins 

 

 หมายเหตุ:  

- ควรจำกัด User Admin ใหšมีเพียงคนเดียวเพ่ือปŜองกันการแกšไขสิทธ์ิของ

ผูšใชšงานใน software ที่ทำใหšเกิดปŦญหาการเขšาใชšงานในการแกšไขมากกวŠา 

1 คน 

- Admin ไมŠสามารถ cut หรือ delete job file ที่วัดคŠาสีตัวอยŠางออกจาก 

software.  
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5. วิธีสรšาง Group user และผูšใชšงาน User 

 1.วิธีการสรšาง Group Users 

 2.วิธีการสรšาง User ผูšใชšงาน software 

 3.วิธีการนำ User ใสŠใน Group Users 

 หมายเหตุ:  

- Users ที่เขšาใชšงาน software จะสามารถใชšงานในเมนูตŠางๆตาม Admin 

ของ Software กำหนดไวšไดšเทŠานั้น 

- Users ไมŠมีสิทธิ์ในการ cut หรือ delete job file ที่วัดคŠาสีตัวอยŠางออก

จาก software. 

6. ขั้นตอนการเปŗด Software EasyMatch QC-ER (แบบยŠอ) 

 Group Admin ของ Software EasyMatch QC-ER 

  Login Account Admin ของ Software  

   1.ดับเบ้ิลคลิ๊กไอคอน EasyMatch QC-ER    

2.ใสŠ User และ Password Admin ของ software เพ่ือเขšาไปตั้งคŠาวŠาจะใหš 

user สามารถใชšงานเมนูไหนไดšบšาง 
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3.เม่ือตั้งคŠาการใชšงานของ User ตŠางๆเรียบรšอยแลšวใหš logout หรือออกจาก 

software เพ่ือเขšาใชšงานดšวยในสิทธิ์ของ user ที่กำหนดไวš 

 Group User ของ Software EasyMatch QC-ER 

  Login Account User ของ Software  

   1.ดับเบ้ิลคลิ๊กไอคอน EasyMatch QC-ER   

2.ใสŠ User และ Password ของ User ที่สามารถใชšงาน software เพื่อเขšาไป

ใชšวัดคŠาสีตัวอยŠาง 

  

3.สรšาง Job file เพื่อวัดคŠาสีของตัวอยŠาง 
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4.อŠานคŠาสีตัวอยŠาง 

 4.1 ตšองการเปรียบเทียบคŠาของตัวอยŠางตšนฉบับใหšอŠานคŠา standard 

กŠอน (ไอคอนรูปคนสีเขียว)    แลšวอŠานคŠา sample (แคอนรูปคนสีแดง)  

ตาม 

 4.2 ตšองการอŠานคŠาสีของตัวอยŠางแบบไมŠไดšเปรียบเทียบกับคŠาของ 

standard ใหšอŠานคŠาสีของตัวอยŠางดšวยเมนูอŠานคŠา sample (แคอนรูปคนสีแดง)  

 

5.เม่ืออŠานคŠาสีของตัวอยŠางเรียบรšอยแลšว save ตามสิทธ์ิที่ user สามารถทำ

ไดšตามที่ admin กำหนด 

6.เม่ือทำการอŠานคŠาสีตัวอยŠางและขั้นตอนอื่นๆตามการใชšงานเรียบรšอยแลšวใหš 

Logout หรือปŗด software  
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7. วิธีการใชšงาน Software EasyMatch QC-ER (Electronic Record)  

(อธิบายตามขั้นตอน) 

7.1 วิธีเปŗด software 

1.    ดับเบิ้ลคลิ๊กไอคอน EasyMatch QC-ER 

 

                                  
 

2. หลังจากนั้นจะมีหนšาตŠางใหมŠเปŗดขึ้นมาเพ่ือใหšใสŠ User & Password (ขึ้นกับผูšใชšงานวŠาจะ 

login ดšวยผูšใชšงาน Admins หรือ User 
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7.2 วธิีการ Add Sensor หรือการติดตั้งเคร่ืองวัดสี (Sensor) เขšากับ Software.  

1. หลังจากที่ login เขšาหนšาแสดงผลแลšวในกรณีที่ยังไมŠเคยติดตั้งเครื่องวัดสีตŠอกับ software 

จะแสดงหนšาจอดังนี ้

                    

2. คลิ๊ก OK เพ่ือเริ่มขั้นตอนการติดตั้งเครื่องวัดสีเขšากับ software โดยเลื่อนเมาสŤไปที่เมนู 

Sensor -> Install/Configure (1) ดังรปูดšานลŠาง 
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3. หลังจากทีเ่ลือก Install/Configure แลšวจะมีหนšาตŠางใหมŠขึ้นมาใหš Add Sensor ใหšเลือก

ที่เมนู Add Sensor 

        

 

4. เมื่อเลือก Add Sensor แลšวจะมีหนšาตŠางใหมŠขึ้นมาใหšเลือกชื่อของเครื่องวัดสีที่ใชšงานโดย

สามารถคลิ๊กที่ลูกศรลงดšานขวา (1) เพ่ือเลือกรุŠนเครื่องวัดสีหรือ sensor ที่ใชšงานในที่นี้เรา

เลือกรุŠน ColorFlex EZ คลิ๊ก Next (2) เพ่ือทำตามขั้นตอนตŠอไปดังรูป 
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5. คลิ๊กเครื่องหมายถูกในชŠอง Standardize Now ออก (1) แลšวคลิ๊ก Finish (2) 

 

 

 

 

 

  

 

6. เลือก Finish เปŨนการ add sensor เรยีบรšอยจากนั้น Restart software แลšวเปŗด 

software EZMQC-ER ใหมŠอีกครั้ง 

1 
2 

1 

2 
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7. เมื่อเปŗด software หลังจาก restart แลšวจะมีรายละเอียดของเครื่องแสดงดšานลŠางเพ่ือ

แจšงวŠาขณะนี้เครื่องวัดสีติดตŠอกับ software ไดšแลšว  

        

 

8. จากการแสดงรายละเอียดรูปดšานบนผูšใชšงานสามารถดูสถานะการติดตŠอของเครื่องกับ 

software ไดšที่อีกที่นึงในเมนู sensor -> Install/Configure ดังรูปดšานลŠางจะแสดงรูŠน, 

serial number และขšอมลูตŠางๆของเครื่อง เปŨนการเสร็จสิ้นการ add sensor คลิ๊ก ok 

เพ่ือทำการ Standardize แผŠนดำและแผŠนขาวตามขั้นตอนตŠอไป 

รายละเอียดของเคร่ืองวัดสีที่ตดิตŠอกับ software  



 
 

 
14 

 

        
 

7.3 วิธ ีStandardize หรือ Calibrate กŠอนการใชšงาน 

1. วางแผŠนดำ (Black Glass) ครอบชŠองวัดตัวอยŠางดšานบนเครื่องแลšวเลือกไอคอน 

Standardize       

 

2. เมื่อเลือกไอคอน standardize แลšว software จะแสดงใหšวางแผŠนดำตรอบดšานบนของ

ชŠองอŠานตัวอยŠางจากนั้นกด Next ดังรูปดšานลŠาง 

ไอคอน standardize  
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แผŠนดำ (Black Glass) และรูปแบบการวางใหšตำแหนŠงจุดสีขาวอยูŠดšานหนšาเครื่องและไมŠ

วางแลšวหมุนบนพื้นหนšา port ชŠองอŠานตัวอยŠาง 

                   

 

3. เมื่ออŠานแผŠนดำเรียบรšอยแลšว software จะแจšงใหšนำแผŠนออกแลšววางแผŠนขาวแทน

จากนั้นกด Next 
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แผŠนขาว (White Tile) และรูปแบบการวางใหšตำแหนŠงจุดสีขาวอยูŠดšานหนšาเครื่องและไมŠ

วางแลšวหมุนบนพื้นหนšา port ชŠองอŠานตัวอยŠาง 

                        

 

4. เมื่ออŠานแผŠนขาวเรยบรšอยแลšวถšา software จะแสดงสถานะ ผŠาน/ไมŠผŠาน การทดสอบ 

Standardize (ในกรณีที่ไมŠผŠานใหšนำกระดาษเช็ดเลนสŤหรือผšาเช็ดแวŠนทำความสะอาด
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หนšาแผŠนทดสอบระวังหนšาแผŠนเปŨนรอย) ถšา Success ใหšกด Finish เพ่ือเขšาขั้นตอนการ

ตั้งคŠาและวัดตัวอยŠางตŠอไป 

 

               

7.4 วิธี Config คŠาของ Scale สีและอื่นๆในหนšา Monitor 

1. หลังจาก Standardize เรียบรšอยแลšวจะเปŨนการ config หนšาแสดงผลการทดสอบโดย 

  
 

 

2. คลิ๊กเมาสŤขวาที่ชŠองแสดงขšอมูลการวัด (Color Data Table) แลšวเลือก configure เพื่อ

เริ่มตั้งคŠาของ Scale สีและรายละเอียดตŠาง 

แสดงชื่อตัวอยŠาง 

(Job Tree) 

แสดงขšอมูลการวัด 

(Color Data Table) 

แสดงขšอมูลแบบ 

(Color Plot 2D) 

แสดงขšอมูลแบบ 

(Spectral Plot) 

แสดงขšอมูลของเคร่ืองวัดสี 

(Sensor Status) 
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3. หลังจากเลือก configure แลšวจะมีหนšาการตั้งคŠาแสดงขึ้นมาดังรูปดšานลŠาง 

                              

 

คล๊ิกเมาสŤขวาแลšวเลือก 

configure 

Scale สีที่ใชšงาน 

เลือกคŠาแสดงความตŠางของสี 

เลือก scale สีเฉพาะกลุŠมงานตัวอยŠางงาน 

แสดงรายละเอียดของขšอมูล 

เมื่อเลือกแลšวใหšกดเพือ่นำไปแสดงผล 

ขนาดตัวอกัษรที่แสดงผล 

จำนวนทศนิยม 
Checkbox เพือปรับชŠองแสดงขšอมูลใหšแคบลง 

เลือกชนิดของแหลŠงแสง 

รายการที่เลือกใหšแสดงขšอมูล 
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4. หลังจากตั้งคŠาที่ตšองการใหšแสดงผลเรียบรšอยแลšวใหšคิลŢก OK เพ่ือยีนยันและนำไปใชšงาน 

 

7.5 วิธีสรšาง Job 

1. หลังจากตั้งคŠา config ของหนšาแสดงผลขšอมูลเรียบรšอยแลšวก็จะเริ่มขั้นตอนการสรšาง 

Job (New Job) ใชšงานวัดคŠาสีของตัวอยŠาง 

 
   

2. เลอืก Save As 

 

 



 
 

 
20 

 

3. ตั้งชื่อ Job file  

 

 

7.6 วิธีอŠานคŠาสีตัวอยŠางเปŨน standard และอŠานคŠาตัวอยŠางเปรียบเทียบ  

 1.เม่ือสรšาง Job file เรียบรšอยแลšวเริ่มอŠานคŠาสีของตัวอยŠางแบบใชšตัวอยŠางแรกเปŨนคŠา 

standard กŠอนโดยวางตัวอยŠางบน port view ดšายบนเคร่ืองแลšวเลือกไอคอน Read Standard 

 ดังรูปดšานลŠาง 

          

 2.เม่ือเลอืกอŠานคŠา standard แลšวใหšตั้งชื่อของตัวอยŠาง 
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 3.หลังจากตั้งชื่อและเลือก OK แลšวที่หนšาแสดงผลจะแสดงคŠาการวัดคŠาสีตัวอยŠางดังรูป 

              

 4.นำตัวอยŠาง standard ออกแลšวนำตัวอยŠางที่ 2 วางบน port view เพื่อทำการวัดคŠาสีตŠอ

โดยเลือกไอคอนอŠานคŠาตัวอยŠาง   หลังจากเครื่องเริ่มอŠานแลšวจะแสดงหนšาตŠางใหšใสŠชื่อแลšวกด 

OK เพื่อนำคŠาไปเปรียบเทียบ 

                             

 

 

 

 

ชื่อตัวอยŠาง  คŠาสีตัวอยŠางที่วัดไดš  
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7.7 วิธีอŠานคŠาสีตัวอยŠางแบบ sample 

1.การอŠานคŠาสีตัวอยŠางแบบตšองการขšอมูลของการวัดแบบที่ไมŠไดšเปรียบเทียบกับ 

standard สามารถวัดไดšโดยเริ่มจากหลังสรšาง Job file แลšวใหšเลือกไอคอนวัด sample 

 เมื่อกดอŠานแลšวจะมีหนšาตŠางใหมŠขึ้นมใหšใสŠชื่อของตัวอยŠางที่ตšองการวัดดังนี้ 

                 
 

 2.หลังจากใสŠชื่อของตัวอยŠางหลังกาวัดแลšวที่หนšา color data table จะแสดงคŠาสีที่อŠาน

ไดšดังรปู 
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7.8 วธิีการสรšาง Standard จากคŠาที่มีอยูŠมาสรšาง New Job  

1. เลื่อนเมาสŤไปที่ชŠอง Job Tree ดšานซšายแลšวคลิก๊ปุśมเมาสŤดšานขวาจะมีหนšาตŠางเมนูใเลือกใชš

งานในที่นี้จะลองนำเอาคŠาสีมาสรšางเปŨน standard ใหšเลือกที่ Enter Standard Data  

ตšองตŠอเครื่องวัดสีกับ software และเปŗดเครื่องถึงสามารถใชšงานในเมนูนี้ไดš 

      

2. หลังจากเลือก Enter Standard Data แลšวจะมีหนšาตŠางเมนใูหมŠขึ้นมาใหšใสŠคŠาสีที่ตšองการ

ใชšเปŨน standard  
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3. ใสŠคŠาสี standard ในชŠอง L*, a*, b* 

             
                         

4. ตั้งชื่อ standard ตามตšองการ 
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5. คŠา standard ในชŠอง job tree ดšานซšาย เมื่อไดšคŠาเรียบรšอยแลšวสามารถวัดคŠาสีตัอยŠาง

เพ่ือเปรยีบเทียบตามขั้นตอนตŠอไป

 
 

6. ในกรณตีšองการสรšางเปŨน sample โดยการใสŠคŠาใหšทำตามขั้นตอนสรšาง standard แตŠ

เลือกเปŨน Enter Sample Data แทนแลšวทำตามขั้นตอน 1-5  

 

 

 

 

 

 

 

 

 

Job tree  คŠา standard ทีส่รšาง
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7.9 การตั้งคŠาเฉลี่ยเพื่อวัดตัวอยŠางและการนำไปใชš 

 เมื่อผูšใชšงานตšองการวัดตัวอยŠางมากกวŠา 1 จุดสามารถใชšงานในเมนู Average (วัดแบบเฉลี่ย) 

ทำตามขั้นตอนดังนี ้

1. เลือก Options -> Average Method 

  

 

2. เมื่อ software แสดงหนšาตŠางใหมŠขึ้นมาใหšตั้งคŠาในการอŠานแบบเฉลี่ยใหšตั้งคŠาดังนี ้

a. Scale = เลอืก CIELAB (ใชš Scale สี CIE L*, a*, b*) 

b. Illuminant/Observer = D65/10 (D65: จำลองแสงแดดสขีาวชŠวงเที่ยง-

บŠาย/10: มุมองศาการมองเห็นเปŨนมุม 10 องศา) 

c. N of N = 3 (จำนวนที่ตšองการใหšอŠานเฉลี่ย) 

              หลังจากตั้งคŠาที่งหมดแลšวคลิ๊ก OK เพื่อยืนยันการตั้งคŠา 
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3. เมื่อตั้งคŠาเรียบรšอยแลšวใหšเลือกที่เมน ูMeasurements -> Average เพื่อใหšมีเครื่องหมาย

ถูกหนšาเมนู Average เพ่ือใหšการอŠานคŠาสีตัวอยŠางเปŨนแบบเฉลี่ยอŠาน 3 ครั้งเฉลี่ยเปŨน 1 

คŠาสีของตัวอยŠางที่วัดไดš 

             

 

 

 



 
 

 
28 

 

4. เมื่อเชค็เปŨนเครื่องหมายถูกหนšาเมนู Average แสดงวŠาการอŠานคŠาสึตัวอยŠางจะอŠานเปŨน

แบบเฉลี่ยตามจำนวนที่ตั้งเอาไวš ถšาตšองการกลับไปอŠานแบบครั้งเดียวไมŠตšองเฉลี่ยใหšทำ

ตามขั้นตอนเดิมแลšวเช็คเอาเครื่องหมายถูกขšางหนšาออกก็จะเปนการกลับอŠาคŠาสีตัวอยŠาง

แบบครั้งเดียวเหมือนเดิม 

                                       

 

5. เริ่มวัดคŠาสีตัวอยŠางตามขั้นตอนตามจำนวนที่ตั้งคŠาไวšและควรกด READ ใหšมีระยะเวลาหŠาง

กันตŠอครั้ง 7 วินาทีเปŨนอยŠางนšอยเพื่อใหšเครื่องงวัดสีทำการเก็บประจไฟฟŜาในการจŠายใหš

หลอด Xenon ทำงานอยŠาเต็มประสิทธิภาพในการอŠานแตŠละครั้ง 
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7.10 การต้ังคŠา image company Logo บนหนšา Report 

 ผูšใชšงานสามารถนำรูป Logo บริษัทไปใสŠใน Report ไดšโดยการตั้งคŠาดังนี ้

1. ไปที่เมนู file -> Configure Company Logo เลอืกที่อยูŠ file รูปที่ตšองการ (ตšองเปŨนรูป

ที่เปŨน format  “bmp” เทŠานั้น) 

 
 

2. เลือกรูปที่ตšองการแลšวกด OPEN -> OK  
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7.11 การต้ังคŠาหัว (Header) และขšอความทšาย (Footer) หนšา Report 

1. เลือกเมนู File -> Header/Footer Setup 

 

 

2. เปลี่ยนขšอความ Header Information ตามทีต่šองการและ Footer ใหšเลือกสัญญลกัษณŤ

ตัวแทนดšานลŠางวŠาตšองการนำเอาคŠาใดมาใสŠเชŠน ตšองการใหšแสดงวันที่ใหšใสŠ %D หรือ %d 

เปŨนตšน เมื่อใสŠคŠาตŠางๆครบแลšวใหšเลือก OK เพื่อยืนยันการตั้งคŠา 
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7.12 การต้ังคŠารูปแบบการออก Job Report 

 ในการทำ Report ของ software สามารถกำหนดคŠาของขšอมูลวŠาจะใหšอยูŠสŠวนใดของ

หนšากระดาษไดšโดยสามารถทำตามขั้นตอนดังนี ้

1. เลือกเมนู File -> Print Job Setup 

 
 

2. เลือก Print Job Setup 
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3. Software จะแสดงหนšาตัง้คŠาวางตำแหนŠงของข็อมูลดังรปูดšานลŠาง 

               

 

4. เลื่อนเมาสŤไปที่ดšานขวาแลšวเลือกขšอมูลที่ตšองการตามลำดับโดยเลือกแลšวดับเบ้ิลคลิ๊กเพื่อ

เลือกใหšมาอยูŠทางดšานซšายในชŠอง Selected Views To Print 
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5. เมื่อเลือกหัวขšอตŠางๆมาวางทางดšานซšายแลšวใหšเลือกคลิ๊กหัวขšอที่ตšองการทางดšานซšายแลšว

ใหšชี้เมาสŤไปตรงชŠองกลางใหšกดเมาสŤคšางแลšวลากคลุมตามขนาดของพื้นที่ๆจะใหšแสดง

ขšอมูลของหัวขšอนั้นโดยการวางรูปแบบจะแทนคŠาดšวยสีที่ตรงกับหัวขšอดšานซšาย ถšา

ตšองการลบชŠองที่วางแบบใหšคลิ๊กเมาสŤ 1 ครั้งเพ่ือลบแลšววางแบบใหมŠ 

             

 

6. ตัวอยŠางเมื่อวางรูปแบบเสร็จแลšวจะเปŨนดังรปูดšานลŠางหลังจากวางรูปแบบเรียบรšอยแลšว

กด OK หลังจากนี้จะสามารถนำรูปแบบการออกแบบ report นี้ไปปใชšงานไดš 
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7.14 วธิีการ Print Report 

 1.เม่ือตั้งคŠารูปแบบ report เรียบรšอยแลšวและตšองการ print report ใหšใชšเมาสŤเลือกคลุมคŠาที ่ 

            วัดแลšวกด print report 

                

 2.เม่ืดกด print job แลšวจะมีหนšาตŠางใหมŠขึ้นมาใหšเลือก printer ที่ตšองการสั่งพิมพŤออก 

            เครื่องพิมพŤ แลšวเลอืก OK (ใน EasyMatch QC-ER การ print job อาจถูกปŗดกั้นไมŠ  

            สามารถใชšงานไดšจาก Admin software)              

รปูแบบหลงัการจัด 
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7.15 วธิีการปŗด software 

 1.หลังจากวัดคŠาสีตัวอยŠางในการปฏิบัติงานประจำวันเรียบรšอยแลšวและตšองการจะออกจาก 

software และปŗดเครื่องใหšเลือ่นเมาสŤไปทีมุ่มบนดšานขวาของ software แลšวคลิ๊กที่ X 

 

 

 2.หละงจากออกจาก software แลšวใหš shutdown คอมพิวเตอรŤตามขั้นตอนแลšวปŗด 

            เครื่องวัดสีโดยดูที่หนšาจอของเครื่องวŠาอยูŠในหนšา Main menu แลšวกดที่ลูกศรชี้ทางดšาน 

           ซšายของหนšาเครื่อง (1) จากนั้นที่หนšาจอจะแสดงใหšกดที่เครื่องหมายสายไฟสีเหลือง (2)  

           เพื่อเปŨนการ shutdown เครื่องตามขั้นตอน 

                                  

 

Close 

1 2 
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7.15 ขšอควรระวังในการใชšงาน 

1. การอŠานคŠาสีของตัวอยŠางในชŠวงเวลาที่ตŠอกันควรเวšนระยะเวลาในการกดอŠาน 7 วินาทีเปŨน

อยŠางนšอยเพ่ือใหšการเก็บประจุไฟฟŜาในการแฟลชครั้งตŠอไปของหลอดไฟมีประสทิภฺาพที่ดี

ในการใชšงานแตŠละครั้ง 

2. หลังจากใชšงานแผŠนดำ / แผŠนขาวและแผŠนเขียวเรียบรšอยแลšวควรเก็บเขšากลŠองเก็บ

อุปกรณŤของชุดเครื่องวัดสีและปŗดฝาใหšสนิทไมŠวางใหšโดนแสงตลอดเวลาเนื่องจากจะมีผล

ทำใหšแผŠนขาวและแผŠนเขียวอาจมีสทีี่เปลี่ยน fade ไปเปŨนผลทำใหšการ standardize ไมŠ

ผŠานและมีผลตŠอการวัดคŠาสี 

3. การทำความสะอาดชŠองกระจกบริเวณชŠองวัดตัวอยŠางไมŠควรกดน้ำหนักแรง 

4. การทำความสะอาดหนšาชŠองกระจกควรใชšกระดาษเช็เลนสŤหรือผšาเช็แวŠนนุŠมๆทำความ

สะอาด 

5. การทำความสะอาดหนšาแผŠนดำ / แผŠนขาวและแผŠนเขียวที่ใชšทำ standardize หรือ 

diagnostic เครื่องควรใชšกระดาษเช็คเลนสŤหรือผšาเช็ดแวŠนนุŠมเทŠานั้นเพื่อปŜองกันหนšาแผŠน

เปŨนรอย 

6. ในกรณทีี่ตšองมีการหมุนตำแหนŠงแผŠนดำ / แผŠนขาวและแผŠนเขียวใหšยกแผŠนขึ้นเล็กนšอย

แลšวหมุนตำแหนŠงไมŠหมุนใหšหนšาแผŠนสัมผัสกับหนšาชุดชŠองอŠานเพื่อปŜองกันหนšาแผŠนเปŨน

รอยอาจทำใหšการทำ standardize ทดสอบกŠอนอŠานคŠาสีของตัวอยŠางไมŠผŠาน 

 

 

 

 

 

 

 



 
 

 
37 

 

7.16 การบำรุงรักษาเคร่ือง 

No. รายละเอียด  ระยะเวลาการทำ 

1 Standardize (ใชšแผŠนดำและแผŠนขาว) เพ่ือ calibrate มาตรฐาน

การทดสอบคŠาของแผŠนดำ

แทนความมืดและแผŠนขาว

แทนความสวŠาง  

ทุกครั้งที่เปŗดเครื่อง 

2 Diagnostic Repeatability (ใชšแผŠนดำ/

แผŠนขาวและวางแผŠนขาวเพ่ืออŠานคŠาซ้ำ) 

เพ่ือทดสอบความนิ่งในการ

อŠานคŠาดšวยแผŠนขาว 

(White Tile) 

ทดสอบเดือนละ 1 ครั้ง 

3 Diagnostic Green Tile (ใชšแผŠนดำ/ขาว

และแผŠนเขียวตามลำดับ) 

เพ่ือทดสอบประสิทธิภาพ

การอŠานคŠาสีโดยมีแผŠน

เขียวเปŨนมาตราฐานการ

ทดสอบ 

ทดสอบ 1 ครั้ง/ 2 เดือน 

 


